
DataView II 
(CD295) 
Dual Line Display 

Revision: 12/2021 
Copyright © 2005 – 2021 
Campbell Scientific
CSL I.D - 572



Guarantee 

This equipment is guaranteed against defects in materials and workmanship. 

We will repair or replace products which prove to be defective during the 

guarantee period as detailed on your invoice, provided they are returned to us 

prepaid. The guarantee will not apply to: 

 Equipment which has been modified or altered in any way without the

written permission of Campbell Scientific

 Batteries

 Any product which has been subjected to misuse, neglect, acts of God or

damage in transit.

Campbell Scientific will return guaranteed equipment by surface carrier 

prepaid. Campbell Scientific will not reimburse the claimant for costs incurred 

in removing and/or reinstalling equipment. This guarantee and the Company’s 

obligation thereunder is in lieu of all other guarantees, expressed or implied, 

including those of suitability and fitness for a particular purpose. Campbell 

Scientific is not liable for consequential damage. 

Please inform us before returning equipment and obtain a Repair Reference 

Number whether the repair is under guarantee or not. Please state the faults as 

clearly as possible, and if the product is out of the guarantee period it should 

be accompanied by a purchase order.  Quotations for repairs can be given on 

request. It is the policy of Campbell Scientific to protect the health of its 

employees and provide a safe working environment, in support of this policy a 

“Declaration of Hazardous Material and Decontamination” form will be 

issued for completion. 

When returning equipment, the Repair Reference Number must be clearly 

marked on the outside of the package. Complete the “Declaration of 

Hazardous Material and Decontamination” form and ensure a completed copy 

is returned with your goods. Please note your Repair may not be processed if 

you do not include a copy of this form and Campbell Scientific Ltd reserves 

the right to return goods at the customers’ expense. 

Note that goods sent air freight are subject to Customs clearance fees which 

Campbell Scientific will charge to customers. In many cases, these charges are 

greater than the cost of the repair. 

Campbell Scientific Ltd, 

80 Hathern Road,  

Shepshed, Loughborough, LE12 9GX, UK 

Tel: +44 (0) 1509 601141 

Fax: +44 (0) 1509 270924
Email: support@campbellsci.co.uk 

www.campbellsci.co.uk 



About this manual

Please note that this manual was originally produced by Campbell Scientific Inc. primarily for the North 

American  market. Some spellings, weights and measures may reflect this origin. 

Some useful conversion factors: 

Area:   1 in
2
 (square inch) = 645 mm

2
 

Length:    1 in. (inch) = 25.4 mm 

1 ft (foot) = 304.8 mm 

1 yard = 0.914 m 

1 mile = 1.609 km 

Mass:  1 oz. (ounce) = 28.35 g 

1 lb (pound weight) = 0.454 kg 

Pressure: 1 psi (lb/in
2
) = 68.95 mb 

Volume: 1 UK pint = 568.3 ml 

1 UK gallon = 4.546 litres 

1 US gallon = 3.785 litres 

In addition, while most of the information in the manual is correct for all countries, certain information 

is specific to the North American market and so may not be applicable to European users.  

Differences include the U.S standard external power supply details where some information (for 

example the AC transformer input voltage) will not be applicable for British/European use. Please note, 

however, that when a power supply adapter is ordered it will be suitable for use in your country. 

Reference to some radio transmitters, digital cell phones and aerials may also not be applicable 

according to your locality. 

Some brackets, shields and enclosure options, including wiring, are not sold as standard items in the 

European market; in some cases alternatives are offered. Details of the alternatives will be covered in 

separate manuals. 

Part numbers prefixed with a “#” symbol are special order parts for use with non-EU variants or for 

special installations. Please quote the full part number with the # when ordering. 

Recycling information 

At the end of this product’s life it should not be put in commercial or domestic refuse but 

sent for recycling.  Any batteries contained within the product or used during the 

products life should be removed from the product and also be sent to an appropriate 

recycling facility. 

Campbell Scientific Ltd can advise on the recycling of the equipment and in some cases 

arrange collection and the correct disposal of it, although charges may apply for some 

items or territories.  

For further advice or support, please contact Campbell Scientific Ltd, or your local agent. 

Campbell Scientific Ltd, 80 Hathern Road, Shepshed, Loughborough, LE12 9GX, 

UK Tel: +44 (0) 1509 601141    Fax: +44 (0) 1509 270924
Email: support@campbellsci.co.uk 

www.campbellsci.co.uk 



Safety 
DANGER — MANY HAZARDS ARE ASSOCIATED WITH INSTALLING, USING, MAINTAINING, AND WORKING ON 
OR AROUND TRIPODS, TOWERS, AND ANY ATTACHMENTS TO TRIPODS AND TOWERS SUCH AS SENSORS, 
CROSSARMS, ENCLOSURES, ANTENNAS, ETC.  FAILURE TO PROPERLY AND COMPLETELY ASSEMBLE, 
INSTALL, OPERATE, USE, AND MAINTAIN TRIPODS, TOWERS, AND ATTACHMENTS, AND FAILURE TO HEED 
WARNINGS, INCREASES THE RISK OF DEATH, ACCIDENT, SERIOUS INJURY, PROPERTY DAMAGE, AND 
PRODUCT FAILURE.  TAKE ALL REASONABLE PRECAUTIONS TO AVOID THESE HAZARDS.  CHECK WITH YOUR 
ORGANIZATION'S SAFETY COORDINATOR (OR POLICY) FOR PROCEDURES AND REQUIRED PROTECTIVE 
EQUIPMENT PRIOR TO PERFORMING ANY WORK. 

Use tripods, towers, and attachments to tripods and towers only for purposes for which they are designed.  Do not 
exceed design limits.  Be familiar and comply with all instructions provided in product manuals.  Manuals are 
available at www.campbellsci.eu or by telephoning +44(0) 1509 828 888 (UK).  You are responsible for conformance 
with governing codes and regulations, including safety regulations, and the integrity and location of structures or land 
to which towers, tripods, and any attachments are attached.  Installation sites should be evaluated and approved by a 
qualified engineer.  If questions or concerns arise regarding installation, use, or maintenance of tripods, towers, 
attachments, or electrical connections, consult with a licensed and qualified engineer or electrician. 

General 
• Prior to performing site or installation work, obtain required approvals and permits. Comply with all

governing structure-height regulations, such as those of the FAA in the USA.
• Use only qualified personnel for installation, use, and maintenance of tripods and towers, and any

attachments to tripods and towers.  The use of licensed and qualified contractors is highly recommended.
• Read all applicable instructions carefully and understand procedures thoroughly before beginning work.
• Wear a hardhat and eye protection, and take other appropriate safety precautions while working on or

around tripods and towers.
• Do not climb tripods or towers at any time, and prohibit climbing by other persons. Take reasonable

precautions to secure tripod and tower sites from trespassers.
• Use only manufacturer recommended parts, materials, and tools.

Utility and Electrical 
• You can be killed or sustain serious bodily injury if the tripod, tower, or attachments you are installing,

constructing, using, or maintaining, or a tool, stake, or anchor, come in contact with overhead or
underground utility lines.

• Maintain a distance of at least one-and-one-half times structure height, or 20 feet, or the distance
required by applicable law, whichever is greater, between overhead utility lines and the structure (tripod,
tower, attachments, or tools).

• Prior to performing site or installation work, inform all utility companies and have all underground utilities
marked.

• Comply with all electrical codes.  Electrical equipment and related grounding devices should be installed
by a licensed and qualified electrician.

Elevated Work and Weather 
• Exercise extreme caution when performing elevated work.
• Use appropriate equipment and safety practices.
• During installation and maintenance, keep tower and tripod sites clear of un-trained or non-essential

personnel.  Take precautions to prevent elevated tools and objects from dropping.
• Do not perform any work in inclement weather, including wind, rain, snow, lightning, etc.

Maintenance 
• Periodically (at least yearly) check for wear and damage, including corrosion, stress cracks, frayed cables,

loose cable clamps, cable tightness, etc. and take necessary corrective actions.
• Periodically (at least yearly) check electrical ground connections.

WHILE EVERY ATTEMPT IS MADE TO EMBODY THE HIGHEST DEGREE OF SAFETY IN ALL CAMPBELL 
SCIENTIFIC PRODUCTS, THE CUSTOMER ASSUMES ALL RISK FROM ANY INJURY RESULTING FROM IMPROPER 
INSTALLATION, USE, OR MAINTENANCE OF TRIPODS, TOWERS, OR ATTACHMENTS TO TRIPODS AND TOWERS 
SUCH AS SENSORS, CROSSARMS, ENCLOSURES, ANTENNAS, ETC. 
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DataView II (CD295) Dual Line Display 
1. Introduction

The DataView II is a two-line, 32-character LCD that displays real time values 
from a CR2xx series data logger along with a predefined description string and 
units string. 

Two buttons allow the user to scroll through the programmed locations that are 
updated as often as they are measured. When the user has not pressed a button 
within a user-defined period (default 120 seconds), the DataView II switches to 
low power mode, drawing a current of less than 1 mA.  

The DataView II is easily configured using the Windows based PC295W and 
Device Configuration Utility packages. 

Throughout this document the terms “DataView II”, “CD295” and 
“DataView2” are used interchangeably.  

FIGURE 1-1. DataView II (CD295) 

1.1 Changes from Version 1 to Version 2 
The original release of the CD295 operating system (V1.0) and PC295W 
(V1.0) supported the CR200-series data loggers only. Version 2 of the CD295 
operating system and PC295W added support for our CR1000, CR800, CR850, 
and CR3000 data loggers, as well as support for their new data types (long 
integers, Booleans, strings, and time stamps). 

NOTE 



DataView II (CD295) Dual Line Display 

2 

To use the new capabilities, both the CD295 operating system (OS) and 
PC295W software needs to be upgraded to Version 2. Refer to Section 4.2.1.4, 
Upgrading the Operating System (OS) (p. 15), to upgrade the CD295 OS. To 
upgrade PC295W, uninstall previous software versions and then follow the 
procedure provided in Section 3.2, Software Installation (p. 3). 

1.2 Normal Operation Overview 
Below is a general description of normal operation of the DataView II 
(CD295). 

When first powered up, the DataView II displays the following greeting, 

Campbell 
Scientific 

and the backlight will be lit. 

After a program has been successfully downloaded, the CD295 is configured 
and connected to the data logger; it is ready for general use. Pressing one of the 
buttons on the CD295 will cause the LCD to display something like the 
example below. 

Temperature 
1.234   deg C 

The top line contains a string referred to as the “Description”, and the second 
line contains both the value retrieved from a Public Variable in the data logger 
and a string referred to as “Units”. The value displayed on the second line can 
be displayed with a user-selectable number of decimal places. 

Together, the combination of “Description”, Public Variable, “Units” and 
number of decimal places, is referred to as a “screen”. The CD295 is capable of 
holding and displaying up to 30 “screens”. There are no limitations on the 
order of screens, or which Public Variables are displayed. Pressing the buttons 
on the front panel of the DataView II will cause the next (or previous) screen to 
be displayed. 

The CD295 will attempt to collect a new value from the data logger under the 
following conditions: 

• The user has changed “screen”
• The scan interval of the data logger has expired

After some time (default 10 secs), the backlight will turn off, however the text 
will remain visible until the unit enters sleep mode (default 120 secs). 
Whenever one of the buttons on the front panel is pressed, these two timers 
(Backlight timer and Power Down timer) are both reset. As a result, the 
DataView II can be woken from sleep mode by pressing either of the buttons. 

Description 

Value Units 
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While in sleep mode the DataView II will continue to respond to PakBus 
communications, however the LCD is turned off and no requests are sent to the 
data logger. 

2. Installation Procedure
Below is a general guide to the steps involved in configuring and programming 
a DataView II (CD295). 

1. Download the latest version of the CD295 OS, PC295W, and the Device 
Configuration Utility from www.campbellsci.eu/downloads.

2. Connect the 9-pin D-connector of the programming cable into the CD295 
data cable and the other end into your computer serial COM port.

3. Using PC295W and the data logger program, configure your screens of 
your DataView II (DV2 file).

4. Using Device Configuration Utility, send the DataView II program (DV2 
file), and change any settings (e.g., PakBus Address).

5. Remove the programming cable.

6. Mount the CD295 into your data logger enclosure.

7. Connect the CD295 data cable to the data logger RS-232 port.

8. Power up the data logger and CD295 and verify correct operation.

3. Software
3.1 Computer System Requirements 
3.1.1 Minimum Configuration 

PENTIUM-class machine with 64 MB RAM running Windows 98. 

3.1.2 Recommended Configuration 
PENTIUM-class machine with 128 MB RAM running Windows 2000/XP. 

3.2 Software Installation 
1. To begin the installation of the PC295W software, download the latest

version of the software from www.campbellsci.eu/downloads and open 
the setup.exe file, which contains the software to be used.

https://www.campbellsci.com/downloads
https://www.campbellsci.com/downloads
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2. After starting Setup.exe you will be presented with a welcome screen
giving a brief introduction to the software. Click OK.

3. The next screen asks where you would like PC295W installed on your hard
disk. If you wish to install into a path other than the default, click Change 
Directory and use the windows dialogue to choose a suitable location. 
Once the path is correct, click the Install icon in the top left corner of the 
window.

4. The next dialogue to appear asks which program group on the start menu,
you would like to add PC295W. The default is usually acceptable;
however, if not, you are free to choose your preferred program group in
this step. Click Continue.
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5. File copying will now begin.

6. Once the Setup is complete, the following window is displayed. You are
now ready to start using PC295W. Click OK.

4. Programming
4.1 PC295W 

PC295W software is a freeware utility provided by Campbell Scientific to 
write programs for the DataView II. 

PC295W first reads the data logger program, to generate the list of Public 
Variables and to determine the scan rate of the data logger. Once this 
information has been determined, the user is able to choose a public variable to 
display, and can associate “Description” and “Units” strings with it to form a 
“screen”. A group of screens forms a user program, and PC295W saves this 
program to disk in a DV2 file.  

The CD295 is a PakBus device, using PakBus communications to 
retrieve data from the data logger. However, the CD295 does not 
support PakBus encryption. When the CD295 is connected to a 
data logger using PakBus encryption, the data logger program 
must include an EncryptExempt() statement with the PakBus 
address of the CD295. Note that doing so will introduce an 
exemption rule to the data logger security rules. 

By default, the first part of the filename is the same as the data logger program 
from which it was generated. So, for example, if you opened station1.cr2 to 
create the DataView II program, PC295W would save the program as 
station1.dv2. This naming convention is strongly recommended, but not 
mandatory. 

NOTE 



DataView II (CD295) Dual Line Display 

6 

4.1.1 Operation 
1. To start PC295W, click Start > Programs > PC295W DataView2

Programming Software > PC295W DataView2 Programming
Software.

2. Once the PC295W program starts you will see the main screen.

3. The first step in creating a DataView II program is to select Create new
DataView2 Program from the File menu. This will open a file browser
window which will allow you to locate the data logger program (with
CR1, CR2, CR3, or CR8 extension). When the correct data logger program
is selected, click Open.

If you already have created a DataView II program that you wish to edit,
select Open Existing DataView2 Program in the File menu. A file
browse window will appear. Locate your DataView II program (.295
extension) and click Open.
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4. If you have chosen to Create a new DataView2 program, a file browse 
window will appear.  
 
To operate correctly, your DataView II needs some information about the 
program running in the data logger to which it will be connected.  
 
PC295W reads the data logger program file you select at this step, and 
extracts information such as the Scan Interval and the list of Public 
variable names. 
 
Locate the data logger program and select Open.  
 

 

5. PC295W will now return to the main screen, however the CRX FileName 
and DataView 2 Refresh Rate will no longer be blank. PC295W has read 
your data logger program and is now ready for you to create a DataView II 
program. 
 
Select the Add Screen button. 
 
Variable to Display has a dropdown list from which you are able to 
choose a Public Variable used in the data logger program. 
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6. The Description and Units fields are free-form text strings that are 
displayed on the CD295 along with the value collected from the data 
logger. These fields can be used to provide a user-friendly description and 
engineering units of the value displayed. It is also possible to choose the 
number of decimal places to be used when displaying the value. 
 
Complete the Description, Units and Decimal Places. 
 

 
 
You can now continue adding screens by repeating steps 5 and 6, as many 
times as necessary. 
 
If the variable you have chosen is not floating point, the Display Options 
panes on the right side of the screen will provide multiple options for 
displaying the variable. The example below shows the Display Options for 
a Boolean variable. 
 

 
 
Long integer data types are used to store both integer whole numbers and 
time stamps. Choose Numeric Value for the Display Option if your long 
integer variable is a whole number. Several display options are offered for 
time stamps (see below). 
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The date stamp will only show meaningful values if the long 
integers are created correctly. For more information, refer to 
Appendix C, Using Time Stamps (p. C-1). 

7. If at any time you would like to return to an earlier screen, you can do so 
by using the Screen Number dropdown list. Also, if you would like to 
delete a screen you can select the screen you would like to delete from the 
Screen Number dropdown list and click the Delete Screen button. 
 

 

NOTE 
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8. After entering all of the screens in your DataView II program, you will
probably want to save your work. Click File > Save As and this will open 
a dialogue in which you can specify a filename and save your DataView 
II program.

If you are modifying an existing program or have already saved your 
work, you can select the Save option which will not prompt for a new 
filename.
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9. Once you have completed and saved the DataView II program, you are 
ready to download the program into the DataView II itself.  

To do this, you must have the Device Configuration Utility 
installed on your computer. Please ensure that it is installed before 
proceeding. 

To continue with programming the DataView II (CD295), please refer to 
Section 4.2, Device Configuration Utility (p. 11). 

From within PC295W, Device Configuration Utility can be started through 
the file menu. Click File > Program a DataView2 with a DV2 file. 

 

4.1.2 Online Help 
PC295W has two items on the Help menu — PC295 and About. About lists 
the version number of the PC295W software, and PC295 contains online help 
to guide you through operation of the software. It is a simple step-by-step guide 
to writing your DataView II program. 

4.2 Device Configuration Utility 
Device Configuration Utility is a freeware utility provided by Campbell 
Scientific for the configuration of PakBus devices. This tool allows the user to 
send programs, upgrade firmware in the device, and modify device settings.  

In the case of the CD295, Device Configuration Utility allows you to download 
your program, and read/modify the following settings: 

Version 
 the operating system version number 
CD295 Address  
 the PakBus address of the DataView II 
Logger address  
 the PakBus address of the data logger from which the CD295 should 

collect values 

NOTE 
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Logger Security Code 
 the security of the data logger – this should always be 0 for the CR200 
Power Down Timer 
 the period of time after which the CD295 should return to sleep mode 
Serial Number 
 the serial number of the DataView 
Backlight Timer 
 the period of time to keep the backlight on 

Before using Device Configuration Utility, it is important to provide power to 
your DataView II (CD295) and connect the serial port of your computer to the 
CD295, using the programming cable provided (see figure below). 

 

4.2.1 Operation 
4.2.1.1 Establishing a Connection 

1. Start the Device Configuration Utility. 

2. Select CD295 from the Device Type on the left-hand side of the window. 
Verify the Serial Port in the bottom left of the window is correct and click 
the Connect button. 
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3. Device Configuration Utility will automatically detect the connection 
speed and PakBus address of the DataView II. Once detection is complete, 
three tabs should appear in the window on the right-hand side. These are 
Program Control, Send OS and Settings Editor.  
 
The Program Control tab is used to send a program to the DataView II, 
and is the most commonly used of the three tabs.  
 
As the name suggests, the Send OS tab is used to send an Operating 
System (OS) to the DataView II. This is used to upgrade the firmware of 
the CD295. 
 
The Settings Editor tab is used to read/modify the addresses and timers 
mentioned above.  

4.2.1.2 Downloading a Program 

1. To download a program, ensure that you are already connected to the 
CD295 and the Program Control tab is selected. Click the Send 
Program button. 
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2. A file browser window will appear. Locate the DV2 file you wish to 
download and click Open. 

When a DataView II program is created, PC295W creates two 
files — the DV2 file for download to your DataView II, and a .295 
file which contains internal configuration information for the 
PC295W program. You should only send the DV2 file to your 
CD295. 

 

3. Device Configuration Utility will download your program to the DataView 
II and return to Program Control. 
 

 

NOTE 
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4.2.1.3 Modifying Settings 

1. The Settings Editor tab allows you to read/modify any device-specific 
settings in the CD295. To change a setting, double-click the settings you 
wish to change, and type the new value. Repeat for as many settings as 
necessary. 

Some settings are read-only, and others have limits on the range 
of acceptable values. A description along with the maximum and 
minimum values appears in the comments box at the bottom of the 
window. 

2. After all changes are complete, click Apply to send the new settings to the 
DataView II. After the settings are applied, Device Configuration Utility 
will show the new values of the Settings from the CD295. 
 

 

3. If after editing a setting, you wish to discard the changes, click Cancel. 
Device Configuration Utility will show the current values of the settings in 
order for you to verify that the changes were discarded. 

4. It is possible to return the DataView II to its factory default settings. To do 
this, click Factory Defaults. 

4.2.1.4 Upgrading the Operating System (OS) 

From time to time, new operating system(s) for the DataView II may be 
released to correct errors in the operating system or to add new functionality. 
To take advantage of this, it is necessary to send the new operating system 
(OS) to the DataView II. 

NOTE 
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1. If you need to send an Operating System to your DataView2, open the 
Send OS tab in Device Configuration Utility and select the Send OS 
button at the bottom of the window. 

It is not necessary to “Connect” using Device Configuration 
Utility to send an operating system. 

 

2. A file browser window will appear. Locate the operating system file (A43 
extension), provided by your supplier, and click Open. 

3. After selecting the operating system file, it will be necessary to power 
cycle the DataView II. Disconnect the power from the CD295 and 
reconnect it. 

NOTE 
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4. The download will begin, and progress bar should begin to fill.  

It is VERY important that the power cable and programming 
cable remain connected while the download is underway. 
Failure to do so may cause permanent damage to the 
CD295. 

 

5. When the download is complete, Device Configuration Utility will display 
a pop-up window to confirm the success or to notify if there was an error.  
 

 

6. Once the download is complete, disconnect power from the CD295 for at 
least 30 seconds to ensure that it has been completely reset. After this, the 
new operating system will run. 

5. Mounting in Enclosure Door 
If the DataView II will be exposed to the elements, it is important to fit the 
CD295 door kit, as explained below. 

1. Use the template provided to mark out the four mounting holes and cut-out 
for the CD295.  

2. Drill the four corner holes using a 4.5 mm drill and cut out the mounting 
hole using a jigsaw or nibbler.  

CAUTION 
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3. Apply a thin coating of neutral-cure silicon sealant between the flange of 
the CD295 and enclosure door. 

4. Use the screws and nuts provided to attach the CD295. Insert the head of 
the screw followed by a flat washer through the front of the CD295. On 
the inside of the enclosure, fit the rubber O-ring washer then the second 
flat washer followed by the dome nut. 

5. If fitted, remove the nut, bolt and washers from the top-left mounting hole 
of the CD295 front panel. 

6. Remove the “nylock” nut, stainless steel and rubber washers from the bolt 
assembly fixed to the CD295 door. At this point, the bolt assembly holding 
tag should be exposed. 

7. Insert the bolt assembly through the top-left mounting hole of the CD295 
front panel 

8. From the inside of the enclosure, fit the rubber washer, stainless steel 
washer and “nylock” nut onto the stainless steel bolt assembly. 

9. After confirming that all hardware has been fitted in the correct order, tear 
off the “Bolt Assembly Holding Tag”. 

10. Tighten the “nylock” nut until the black rubber washer is tightly 
compressed. 

If you are fitting the CD295 door kit, only three bolts are required 
to be fitted at this step. The bolt in the top-left corner of the CD295 
front panel is not required. In this case, only fit the remaining 
three bolts, and use the longer (25 mm) bolt supplied in the door 
kit in the top-left hole. Do not over tighten as this will cause 
damage to rubber washer. 

 

See Appendix A, CD295 Door Kit Assembly Diagram (p. A-1), for the assembly 
diagram for the CD295 door kit. 

NOTE 
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6. Shipping Kit
The CD295 DataView II Shipping Kit includes: 

• CD295 DataView II display

• CD295 programming cable

• PC295W software on CD

• CD295 Mounting Template

• 4 x stainless steel mounting screws, dome nuts, stainless steel and
rubber washers

If the CD295 is to be mounted in the front door of an enclosure, the CD295 
door kit will also be included. This kit includes: 

• CD295 stainless steel door

• Stainless steel screw with nylon spacer, power and programming
cables, rubber and stainless steel washers, and “nylock” nut

• CD295 door mounting diagram

7. Hardware
SPECIFICATIONS 

Physical 
Width: 130 mm (5.1 in) 
Height: 100 mm (3.9 in) 
Depth: 30 mm (1.2 in) 
Weight: 235 g (8 oz) 

Power Supply: 8-16 VDC (12 V nominal)

Power Consumption (at 12 Vdc) 
 Active with backlight: 30 mA 

Active without backlight: 3 mA 
Asleep: 1 mA 

Communications 
Physical protocol: RS232 DTE 
Network protocol: PakBus 
Configuration protocol: Device Configuration Utility 

Environmental 
Temperature 

Operating: –20 to 55 °C
 Asleep: –25 to 70 °C
Humidity: IP65 when mounted in enclosure door with

supplied sealant.
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General 
 Number of screens: 30 max 
 Value update interval: 1 – 65535 sec 
 Backlight period: 0 – 60 sec (default 10) 
 Power down period: 5 – 254 sec (default 120) 
  (255 = never sleep) 

 CD295 address: 1 – 4094 (default 4090) 
 Logger address: 1 – 4094 (default 1) 

 Description string: 16 chars max 
 Units string: 8 chars max 
 Decimals: 0 – 6 digits after decimal 

8. Problems 
• Symptom 

 
The DataView II displays “Waiting” in every location. 
 
Explanation 
 
This message indicates that the DataView requested a public variable from 
the data logger, but has not yet received a response.  
 
Things to check 
 
Is the DataView II connected to the data logger? 
 
 Check the serial cable from the DataView II to the data logger. 
 
Does the data logger have power? 
 
 Check the power supply to the data logger. 
 
Does the PakBus address of the data logger match the “Logger Address” 
in the CD295? 
 
 Using Device Configuration Utility, check that the “Logger Address” 
 setting in the DataView II and the PakBus address of the data logger 
 match (refer to your data logger manual). 
 
Is the baud rate of the data logger RS-232 port set to 9600 or auto? 
 
 By default, the data logger serial port speed should be suitable for 
 the CD295. If it has been manually changed, it may need to be 
 adjusted. 
 
Is this the right version of the DataView program for the data logger 
program? 
 
 It is important that the program that is running in the data logger is 
 the same as the one used when the DataView II program was written. 
 If not, then the DataView II program may need to be re-written. 
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Could the data logger be too busy to answer? 

Consider the execution of the data logger program, and modify if 
necessary. 

• Symptom

The DataView II displays “Waiting” in a few (but not all) screens.

Explanation

This message indicates that the DataView requested a public variable from
the data logger, but has not yet received a response.

If some screens function correctly, then the data logger address, is 
correct, and the data logger is answering requests correctly. 

Things to check 

Is this the right version of the DataView program for the data logger 
program? 

It is important that the program that is running in the data logger is 
the same as the one used when the DataView II program was written. 
If not, then the DataView II program may need to be re-written. 

• Symptom

After sending a program to the DataView II, it displays “No program” and
won’t show any of my screens.

Explanation

The “No program” message indicates that the current program in the
DataView II is incomplete or incorrect.

No permanent harm is done by sending an incorrect file, however it will
not execute.

Things to check

Did you download the correct file?

It is very important that you select the DV2 file that you created with 
PC295W, and not the 295 file which is only created for internal use 
by the PC295W software itself, or any other file on your computer. 

Try downloading again. 

Could your DV2 file be corrupt? 

No software other than PC295W should be used to edit DV2 files. 
Even a slight change to the file is enough to cause the CD295 to 
reject the program. 

Try recreating the DV2 file in PC295W and download it again. 
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9. Temperature Extremes and LCD Adjustment
The CD295 has been tested to –20 ºC. It will perform at this temperature 
although the display may be sluggish and dim.  

Under temperature extremes, the CD295 liquid crystal display (LCD) may 
become difficult to read. LCD contrast can be adjusted by inserting a small 
jeweler’s screwdriver (preferably plastic) into the round hole on the back of the 
CD295 cover and adjusting the LCD contrast potentiometer. 
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Appendix A. CD295 Door Kit Assembly 
Diagram 
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Appendix B. CD295 Mounting Template 
(NOT TO SCALE – REFER TO MOUNTING TEMPLATE SUPPLIED 
WITH CD295) 
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Appendix C. Using Time Stamps 
At the time of release of this document, the CRx000 series of data loggers do 
not support variables of a “date” type. Dates are currently recorded in a long 
integer as the number of seconds that have elapsed since 1/1/1990 00:00:00. 
The DataView II is capable of displaying these values in Gregorian Date 
format (i.e., Day, Month, Year, etc.) in a number of different representations. 

Below is an example CR1000 program to record a timestamp for display on a 
CD295:  

Public Time as Long 
BeginProg  

Scan (1,Sec,0,0)  
Time = Public.TimeStamp(1,1) 
NextScan  

EndProg 

In this case, when creating the DataView program in PC295W for this variable, 
the user should select one of the date representations instead of Numeric 
Value as per the screenshot below:  

In this case, the DataView II would display the time as below: 

Timestamp  
24/01/2007 9:34 

Please note: If this value is displayed using Numeric Value, the DataView II 
would show something like this:  

Timestamp 
538479240 
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